Raise Process
Non Union and Union Professional
and Supervisory Staff
Resource Guide

This resource guide will build the knowledge base for those who will utilize Cognos Contributor to enter raise allocations: criteria, data entry, process, submission, and workflow.

The application for professional raises will be available for entry from September 5 to 22, 2017

OPB (Cognos Access and Functionality)
Denice Beckwith
beckwi37@msu.edu

Human Resources (Eligibility and Raise Entry/Processing)
Rebecca Hallisy
hallisy@hr.msu.edu
## Table of Contents

Chapter 1: Overview of Raise Process ................................................................. 1

Chapter 2: Eligibility Criteria ............................................................................... 4

Chapter 3: Key Dates .......................................................................................... 5

Chapter 4: Installing Contributor Web Client ..................................................... 6

Chapter 5: Security Rights .................................................................................. 7

Chapter 6: Open Application .............................................................................. 8

Chapter 7: Workflow ........................................................................................... 9

Chapter 8: Workspace .......................................................................................... 11

Chapter 9: Application Overview .................................................................... 13

Chapter 10: Application Walkthrough ............................................................... 14

Chapter 11: Validations ....................................................................................... 18

Chapter 12: Submit or Reject Data .................................................................... 19

Chapter 13: Print Data ........................................................................................ 22

Chapter 14: Professional Raise Report ............................................................... 23

Chapter 15: Summary ......................................................................................... 24

For Questions

Glossary

Other Functionality in Contributor
Chapter 1: Overview of Raise Process

Introduction to the Professional Raise Process
The Coalition of Labor Organizations at Michigan State University (MSU) negotiates salary increases for union staff at MSU based on health care costs. The contracts further detail how this raise is to be distributed. Non-union staff, not covered by the Coalition agreement, is included in this process for raise consideration. The union increases include a flat rate general percent and a merit pool. The non-union increase includes only a merit pool, which is equal to the combined percent of the union general and merit pool. All salary adjustments are effective on October 1, 2017.

An optional special increase may be given during the raise process in the unusual event that an employee is determined by their department to receive a raise amount outside of the contractual general and merit components. This optional special increase is available to both union and non-union groups and is effective on October 1, 2017.

Cognos Enterprise Planning Raise Model
The Cognos Enterprise Planning raise model, located in the EBS portal, is the application used by units to designate annual raise recommendations. Union and non-union professional (including nurses) and supervisory staff actively employed as of September 30, 2017 are listed within the Cognos Enterprise Planning raise model called R03. Information in the raise model for these staff members, such as the salary, job, organizational unit, etc., is from data in the HR/Payroll System that is effective of September 30, 2017. Staff will only appear on lists in the raise model by employing organizational unit. The raise model opens in September and units have three weeks to enter raise amounts into the model.

Data Capture
The raise model reflects all personnel actions that have been processed in the HR/Payroll System as of August 29, 2017.

Control Total Figures
The raise model includes columns for units to provide merit raise amounts and optional additional increases. All salary adjustments are provided in dollar amounts. A calculated control total is provided by unit and by MAU and dynamically changes based on the amounts entered into the model. Raise control figures for the merit increase must be fully used at the MAU level (total dollars given may not be more or less than the control at this level), but at the unit level the total dollars given may be greater or less than the control.

<table>
<thead>
<tr>
<th>Professional Employee Groups</th>
<th>General Increase %</th>
<th>Merit Raise %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Union APA</td>
<td>0.76%</td>
<td>1.140%</td>
</tr>
<tr>
<td>Union APSA</td>
<td>0.475%</td>
<td>1.425%</td>
</tr>
<tr>
<td>Non Union APA and APSA</td>
<td></td>
<td>1.9%</td>
</tr>
<tr>
<td>Nurse</td>
<td></td>
<td>1.9%</td>
</tr>
</tbody>
</table>

Union and Non-Union Professional Raise Process
Last edited: 8/21/2017 4:45 PM
Page 1
Optional Special Increases
Space has been provided in the raise model for departments to enter an additional special increase. This would take the place of any additional raise departments would have entered separately outside of the general and/or merit increase process. This special increase is optional. No control total is provided for this special increase and the department is expected to fully fund this increase independent of the annual raise process.

If provided, the optional special increase will be effective October 1 of the raise year just like the general and/or merit increase. Similar to the general and merit increases the optional special increase will be split proportionally across existing funding lines. Processing will be completed along the same timeline to be included in the raise notification process and to allow payment in the October check.

Requirements for the 2017 Optional Special Increase:
1. Departments must complete and attach a Special Increase for Support Staff Employees Supporting Documentation Form in the raise model for each employee receiving the optional special increase. The form can be obtained from two locations:
   https://www.hr.msu.edu/ua/recognition/support-staff/documents/SpecialIncreasesSSEmps.pdf

2. When using this form as part of the raise process, the Current Salary field on the form should reflect the 09/30/2017 salary. The New Salary field should reflect the 09/30/2017 salary plus the general, merit (if applicable) and special increase amount.

3. Each form will be reviewed by Human Resources first, regardless of increase amount entered, prior to entering the raise in the HR/Payroll System.

Merit Raise Guidelines
Human Resources has provided guidelines and FAQs to assist administrators in making merit pay determinations. Communicating about merit pay decisions as the process unfolds positively affects employee morale and establishes an atmosphere of transparency. The guidelines on our website are designed to infuse the merit pay process with opportunities for dialogue between supervisors and employees. These guidelines can be accessed here:
https://www.hr.msu.edu/ua/recognition/support-staff/raise-process.html
Approval of Raises
Security, access and workflow will be addressed in Chapter 5 of this document. However, the Administrative Professional Association (APA) contract requires that the employee’s direct supervisor review, approve, and discuss with the employee the merit raise given. To meet this requirement, it is expected that for each union APA employee, the direct supervisor is given a paper copy of the final raise amount and a wet signature from the supervisor is collected.

Individual copies of these signed increases may be kept in the department’s personnel folder for the employee for no less than one year. OR, a comprehensive raise list signed by all supervisors may be kept in a separate file. To assist with this task, the current supervisor of record will be listed in the raise model. If, on review, this is not the correct supervisor for the employee please enter the correct supervisor via the Actions tile – Position Details and Relationships tile under the Enterprise Business Systems Portal.

Reconciling Data Changes Affecting Control Totals
While the raise model is open, Human Resources will reconcile changes to employee records in the HR/Payroll system with data in the Cognos raise model. Changes to raise model with updated data will occur after 5:00 p.m. on Monday and Wednesday during the raise process. Organizational units affected will be emailed the following day, alerting them to changes. When the raise model is closed, Human Resources will continue to manually balance totals until raise data is loaded in the HR-Payroll System. Balancing after that point is done on an as-needed basis

Enforcement of Minimum Salaries
After the raise has been applied, Human Resources will analyze FTE salaries to ensure that salaries meet the minimum pay ranges. Those individuals whose FTE salary falls short of the minimum range will automatically be adjusted to the minimum.

Human Resources Review and Finalization of Data
Once the raise amounts have been submitted in the raise model, Human Resources identifies any changes to the data that occurred between the time of the data capture for the raise model and the time of the raise update in the HR/Payroll System. Human Resources will review these changes and modify the final salary accordingly. The final upload of the raise amounts into the HR/Payroll System will occur at the beginning of October.

Raise Letters
After the raise amounts have been applied to the salaries in the HR/Payroll System, raise letters will be made available to each organizational unit through a Business Intelligence report available in the EBS Portal at this location:

1. Click on the Business Intelligence tile in the EBS Portal.
2. Browse to this location- Public Folders > HR-Payroll Folder > University HR-Payroll Reports > HR Unit Reporting Admin and Manager Self Service Reports > HR Unit Reporting Administrator Reports > Support Staff October Raise Letters – HRP995*

* The ability to access the raise letter reports is dependent on the HR Unit Reporting Admin role for your specific college/MAU or department. Access can be requested through an eARM via IT Services - https://earm.itservices.msu.edu/

The raise letters include the new annual salary and will be available to print no later than October 13, 2017.
Chapter 2: Eligibility Criteria

General Information
There are standard criteria defined within the Coalition and union agreements to determine whether an employee is eligible to be included in the raise process.

Eligibility Criteria
The following are the eligibility criteria for inclusion in the professional raise process. In some cases, Human Resources has systematically removed the individuals from the raise model who do not meet the criteria. This is noted under applicable eligibility criteria below.

The following are the eligibility criteria for inclusion of individuals in the 2017-18 process:

1. Administrative Professional, Administrative Professional Supervisory and Nurses hired on or before September 30, 2017, are eligible for salary increases unless otherwise specified.
   Note: Human Resources has systematically removed individuals not meeting this criteria from appearing in the raise model.

2. Staff meeting criteria one who are currently on long-term disability or layoff should not be included for consideration for salary increase in this process. Their salary rates should be adjusted after return to work.
   Note: Human Resources has systematically removed individuals on long-term disability and layoff from appearing in the raise model.

3. Staff meeting criteria one who have failed two consecutive performance evaluations will be included in the raise process and will receive any general increase given for their group. However, they may not receive a merit increase. The dollars for their increase may be redistributed to other in the organizational unit and/or MAU.
   Note: Human Resources has systematically set the ‘Merit Eligible’ flag for these records to ‘no’.

4. Staff meeting criteria one that have entered into a ‘Special Agreement’ should not be included for consideration for salary increase in this process. Their salary increases must fall in line with the terms of their agreement.
   Note: Human Resources has systematically removed individuals on special agreement from appearing in the raise model.
## Chapter 3: Key Dates

### 2017-18 Professional Staff Raise Process Schedule

**Revised 7/19/2017**

<table>
<thead>
<tr>
<th>Dates</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wednesday, August 30</td>
<td>Professional staff data LOADED into raise application.</td>
</tr>
<tr>
<td>Tuesday, September 5</td>
<td>Professional staff raise process available online: Units may ENTER raises online (about 3 weeks). HR to reconcile raise data twice a week and contact MAUs with changes while raise model is open.</td>
</tr>
<tr>
<td>Friday, September 22 (MAU Deadline)</td>
<td>Raise process CLOSES; Electronic approval COMPLETED. Please see communication from your MAU on internal deadlines.</td>
</tr>
<tr>
<td>Monday, September 25 through Thursday, September 28</td>
<td>Raise files REVIEWED by Human Resources for processing.</td>
</tr>
<tr>
<td>Friday, September 29 through Wednesday, October 11</td>
<td>Raises LOADED into the HR/Payroll System, including manual corrections.</td>
</tr>
<tr>
<td>Friday, October 13</td>
<td>Raise notifications AVAILABLE electronically via BI report per MAU/Department security access to MAUs for distribution.</td>
</tr>
</tbody>
</table>

*Note: Units will have different internal deadline dates.*
Chapter 4: Installing Contributor Web Client

Cognos Contributor Client Installation Instructions – New Users

Users will need to install the Cognos Contributor Client before they can open applications. To install the Contributor Client, follow instructions within the following document filed on the Office of Planning and Budgets portal under “Required Software”. URL Link: https://opb.msu.edu/functions/budget/cognos.html.

Cognos Contributor Client Installation Instructions – Current Users

Starting January 12, 2016 on Windows machines, both IE9 and 10 will no longer receive security updates which requires users to download IE11. If you use Internet Explorer, please update to IE11 which Cognos EP now supports.

Steps to Download IE11:
2. Click the Download button on this page to start the download.
3. Do one of the following:
   a. To start the installation immediately, click Open or Run this program from its current location.
   b. To copy the download to your computer for installation at a later time, click Save or Save this program to disk.
4. Follow Microsoft IE11 loading steps.

General Information about IE11 Set-Up:
- Within the IE11 Compatibility View Settings, be sure to include msu.edu.
- You may have to completely shut down your computer for the updated settings to load.
- If you encounter issues with the EBS portal opening, you may have to add https://ebs.msu.edu to your Trusted Sites.
- If you are having difficulty opening Cognos EP applications on the web, please follow the steps in this document: Troubleshooting Cognos EP Web Client.
- If you still encounter an issue with Cognos EP opening, then follow the directions to uninstall and reinstall the Contributor Web Client. The URL for the installation procedure is: https://opb.msu.edu/functions/budget/documents/cognos-planning/contributor_install.pdf.
Chapter 5: Security Rights

Access to the applications is determined by the security roles granted within D6501. Workflow screens will be different depending on the security role entered for each application.

- **Cognos EP Viewer** – users get “view only” rights in system.
- **Cognos EP Submitter** – users may view, edit and save changes, as well as submit data for their organization(s) for central approval. This role is appropriate for fiscal officers, deans or administrators, as identified by MAU.

A fiscal officer with “submit” rights for their MAU organization has the right to view, edit, reject and submit for all of their organizations.

**Security Groups in D6501**

The Cognos EP security groups are decentralized to be managed directly within D6501.

- The following is the path to the ARM form for requesting access to the application in Cognos EP: http://aissecuritycontact.ais.msu.edu/arms/index-ebs.html.
  - At the bottom of this screen you will find Cognos Enterprise Planning section.
  - Select the PDF link in the last column: EBSUnitCognosEPRoles.pdf.

- Contact the Help Desk (ithelp@msu.edu) with questions about completing ARM forms.

- Contact Denice Beckwith (beckwi37@msu.edu or call 353-0864) or Val Thebeau (thebeau@opb.msu.edu or call 432-0219) with questions on security roles.

The following is the format for security groups in D6501: Cognos EP <MAU>-<Application>-SUBMIT or VIEW.

Example of security groups for raise applications:

- /group/EBSP/EP/10002000-RP-SUBMIT
- /group/EBSP/EP/10002000-RP-VIEW
- /group/EBSP/EP/10002030-RP-SUBMIT
- /group/EBSP/EP/10002030-RP-VIEW

There are a number of security groups in D6501 for Cognos EP. **Using a filter within the “Title” field will help to show a listing of Cognos EP groups for your MAU. Example of filter: %10002%**
Chapter 6: Steps to Open Raise Application

1. Enter the URL for the Cognos EP site: https://ep.ebsp.msu.edu/cognos/ or log in through the EBS website (ebs.msu.edu) and within “Enterprise Business Systems” or “Report” click on the “Planning & Budgets” tile.


3. When you log on to Contributor, you see on the left side a graphical overview of all the organizations you are responsible for; and the colored circles represent the status of the data entry for organizations.

4. To start using Contributor, in the tree on the left side of the screen, click an organization and a table will appear on the right side of the screen. Your screen might look different than what is shown below.

5. To start working, click an organization within the “Which is made up of:” section of the screen (right side of the screen). This opens the organization in a grid where you can view and enter data.

Note: If your browser appears to have frozen, try refreshing the web page. If that does not work, you will have to restart the browser.
Chapter 7: Workflow

The Workflow screen appears when you log on to Contributor. It consists of a tree, a table, and approval hierarchy. The tree on the left side of the screen lists, in hierarchical form, the area of responsibility for the user. The look of the “tree” depends on the rights of the user. When an item in the tree is clicked, a table with the details for the organization appears on the right side of the screen.

The Tree

Each item in the tree has an icon that indicates the current state of the data.

<table>
<thead>
<tr>
<th>Icon</th>
<th>State and description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="circle.png" alt="Circle" /></td>
<td>Not started</td>
</tr>
<tr>
<td><img src="circle.png" alt="Circle" /></td>
<td>No changes have been saved to the data, although the organization may have been opened for editing.</td>
</tr>
<tr>
<td><img src="dot.png" alt="Dot" /></td>
<td>Work in progress</td>
</tr>
<tr>
<td><img src="dot.png" alt="Dot" /></td>
<td>The data was saved but not submitted. You can change and submit data in this state.</td>
</tr>
<tr>
<td><img src="key.png" alt="Key" /></td>
<td>Locked</td>
</tr>
<tr>
<td><img src="key.png" alt="Key" /></td>
<td>The data was submitted and the organization plan was locked. Data in this state is read only. If an organization’s plan is rejected, its state returns to Work in progress.</td>
</tr>
</tbody>
</table>
Incomplete: At least one item belonging to this item is Not started, and at least one other item is in a state of Work in progress, Locked, or Ready. Data in this state was aggregated. The Incomplete state applies only to review organizations.

Ready: All organizations belonging to the reviewer are locked. The data is ready to be submitted to the next level in the hierarchy.

Currently being edited or annotated
The organization is opened for editing or annotating. Users end an edit session by closing the grid or by submitting the organization.

Out of date
Data in the organization needs restructuring to reflect changes in the application, or system data must be imported.

Currently being edited or annotated and is out of date

**The Table**
The table on the right side of the screen gives information such as the workflow state of the organization, the current owner, the reviewer, and when the organization data was last changed.

If a document is attached, an icon (<Component Icon> ) appears next to that item.
Chapter 8: Workspace

Parts of the Contributor Workspace

The Contributor workspace contains the following parts:

- **Tabs** – a separate tab represents each cube in the application
- **Dimension Bar** – shows the dimensions that are in the rows, columns, and context
- **Dimensions** – groups of related data, such as organizations, semesters, fiscal year, etc.
- **Grid** – where you add or edit data
- **Grid Handles** – where a dimension or tab can be “grabbed” to move it within the grid

Reset View

If you want to revert back to the default grid or tab views, select Reset Tabs only, Reset Grid only, or Reset both Tabs and Grid from the **View** menu by selecting **Reset Views**.
Common Operations

The most common selections from the task bar: Take Ownership, Suppress Zeros, and Submit.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Take Ownership</td>
<td>Users can access and modify the entries they own.</td>
</tr>
<tr>
<td>Add Commentary</td>
<td>Notes can be added to a plan. This is done by annotating a cell, a tab, or the whole model. Also notes can be attached to any cell regardless of its format. This is particularly useful for providing additional information regarding a particular cell.</td>
</tr>
<tr>
<td>Browse Commentary and Documents</td>
<td>Allows owner to view documents, edit comments and delete comments.</td>
</tr>
<tr>
<td>Swap Rows and Columns</td>
<td>Swaps the rows and columns that currently appear in the view.</td>
</tr>
<tr>
<td>Suppress Zeros</td>
<td>Hides blank rows and columns that contain all zeros.</td>
</tr>
<tr>
<td>Auto size Visible Range</td>
<td>Adjusts the rows and columns so that all the data is visible.</td>
</tr>
<tr>
<td>Submit</td>
<td>If you are happy with all the contents, submit from either the workflow screen or from the grid by clicking the submit button.</td>
</tr>
<tr>
<td>Reject</td>
<td>If you are not happy with the contents, and you have appropriate rights, you can reject, either from the workflow screen, or from the grid by clicking the reject button. Rejecting changes workflow from Locked to Work in Progress. It must be modified and resubmitted.</td>
</tr>
<tr>
<td>Validate</td>
<td>Verifies that the data entries or changes conform to existing business rules.</td>
</tr>
<tr>
<td>Help</td>
<td>Contributor documentation is available online by clicking the help button.</td>
</tr>
<tr>
<td>Note</td>
<td>Data that you can edit has a white background. Read-only data has a pale gray background. If you are not the current owner, the data opens in a read-only view.</td>
</tr>
</tbody>
</table>
Chapter 9: Application Overview

The following is a view of how the tabs within R03 Professional Raise application link:

MSU R03 Professional Raise Application

The purpose of the application is to collect general increases, merit raises and optional special increases for Professional, Supervisory, and Nursing staff, while providing decision makers with relevant personnel information. The ‘Rate Assumptions Prof’ tab contains the raise percentages, which are used to determine control totals and recommended raise amounts. These values are fed into the ‘Raise Allocation Prof’ tab, where the actual Merit raise and Optional Special Increase amounts are entered. The ‘Raise Consolidation Prof’ tab contains basic summary information and the total amount of funds available for distribution.

Raise control figures for the merit increase must be fully used at the MAU level. Total raise dollars given at the unit level may be greater or less than the control.
Chapter 10: Application Walkthrough

This chapter explains the function and operation of each tab in the R03 Professional Raise application.

Raise Allocation Prof

The Raise Allocation Prof is used to record the Merit raises and Optional Special Increases. Various personnel information is located in this tab to assist for reporting and decision making purposes. The following section is a walkthrough of inputting data into the Raise Allocation Prof tab.

1. Once the organization selected is open, click on Take Ownership icon ( ).
   
   **Note:** Upon taking ownership, the Actual MERIT Raise Given and OPTIONAL Special Increase column will become white; and you will be able to enter data in them. These are the only two columns in the application to enter data into.

2. **Freeze the first column.** Freezing the first column or so may improve your ability to navigate and enter data. This reduces the amount of horizontal scrolling needed to line up a name with an amount. This is done by clicking View -> Freeze Panes
   
   **Note:** To freeze the Person Name column, put the cursor into the first cell in the Personnel Number column, and then click freeze panes. The freeze panes functionality will freeze the left and top sides of where the cursor lies, when activated.

3. **Total as top row.** This is done by right click on the Grid Handle above the row number -> select Layout -> Hierarchical
4. **Enter** the MERIT raise amount into the **Actual MERIT Raise Given** column.

   **Note:** Remember that the **Merit Raise $** column is used to generate the available amount to distribute, the **Actual Merit Raise Given** column is the amount that the employee will be receiving. If you do not enter an amount in the **Actual Merit Raise Given** column, then the employee will not receive a merit raise.

5. **Enter** the Optional Special Increase amount into the **OPTION Special Increase $** column.

   ![Table]

<table>
<thead>
<tr>
<th>OPTIONAL Special Increase %</th>
<th>OPTIONAL Special Increase $</th>
<th>New Base Salary Increase %</th>
<th>New Base Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.17%</td>
<td>$100.00</td>
<td>2.17%</td>
<td>$61,300.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.00%</td>
<td>$63,036.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.00%</td>
<td>$52,002.64</td>
</tr>
</tbody>
</table>

6. **Attach** approved **Support Staff Special Increase Supporting Documentation form** within the last column of the worksheet.

   ![Form]

7. **Convert to a printable view.** The following views may be helpful to assist in printing an individual employee’s data. These views are from the **Raise Allocation Prof** tab.

   a. **DEFAULT VIEW**

   ![DEFAULT VIEW]

   **Note:** To return to the **DEFAULT VIEW**, click **View -> Reset Views -> Reset Both Tabs and Grids**
b. **SINGLE PERSON VIEW** – arrange dimension in the order shown below

![SINGLE PERSON VIEW Diagram](image1.png)

**Note:** The Raise-R dimension contains row number values. Each person has their own row value. Use the Raise-R dimension to flip through your employees. Make sure you have the correct group and line number selected.

c. **ALL EMPLOYEES VIEW SEPARATED BY EMPLOYEE GROUP** – Same view as previously shown but provides a listing of employee groups

- **Suppress Zero Rows** while in the **default** view

![Suppress Zero Rows](image2.png)

- **Configure** the dimensions as below

![Configure Dimensions](image3.png)

**Note:** The RA Employee Groups Prof contains the four employee groups, i.e. Union APA, Union APSA, Non Union APA and APSA, and Nurse. Make sure you have the correct group selected.

8. **Print the chosen view.** You can quickly export to a tab in Excel where you can format and print the data. **Select File -> Export -> Quick Export.** Excel opens with the data from the current tab.

![Quick Export](image4.png)

**Note:** It is best to suppress zero rows and columns before exporting data to Excel.
9. **Correct validation problems.** See Chapter 11 for a list of validations within the R03 application. The following screen will appear when there is an invalid entry within the application. The green checkmark button (✓) or a save will activate a validation check.

**Note:** *Click on the link to be taken directly to problem cell. Saving is permitted; however, submission will be blocked with a validation error in the R03 application.*

10. Once completed select Submit icon (☐). The workflow icon will change to a padlock (🔒).
Chapter 11: Validations

Check Validations

If you enter a value in a cell that is outside the bounds of the rule, a warning message is shown when you attempt to submit or save the plan. You must correct the data before you can submit.

- If you get a warning message, in the Validation Error dialog box, click the error to view its location in the grid.
- The cursor goes to the first offending cell of the first failed rule.
- If there are other validations rule messages, they will appear one after another.

R03 Professional Raise Validations

**Raise Allocation Prof Tab**

- If "No" is indicated in the "Merit Eligible?" column, then the MERIT RAISE amount must be ZERO. *Note: This will stop you from submitting an organization.*

- A negative raise amount in the Actual MERIT Raise Given or OPTIONAL Special Increase column is not valid. *Note: This will stop you from submitting an organization.*

- If a raise amount has been entered within "OPTIONAL Special Increase $" column, then do the following:
  - SELECT “See Attachment” within "Insert JUSTIFICATION for OPTIONAL Special Increase" column.
  - INSERT a signed and scanned copy of the Support Staff Special Increase Supporting Documentation form within the same cell. *Note: This will stop you from submitting an organization.*

**Raise Consolidation Prof Tab**

- Raise control figures for the merit increase *must be fully used at the MAU level*. Total raise dollars given at the UNIT level may be greater or less than the control. A hard stop has not been entered in the model, but MERIT control totals are to be adhered to closely at the MAU level. Human Resources will not accept any final submissions until MERIT raise amounts are met and not exceeded.
Chapter 12: Submit or Reject Data

Submit Application
At the end of the Professional Raise Process, the data entered into the application needs to be submitted to Human Resources. The following scenarios demonstrate how to submit an organization one at a time and the other shows how to submit multiple organizations at one time.

Submitting a Single Organization
1. Open an organization within the MSU R03 Professional Raise application workflow screen (listing of organizations on the left side of the screen).
2. Be sure that you have taken ownership of the organization that you are submitting; otherwise, you will not be able to submit the organization.
3. Verify that all raise entries are correct and are matching the control totals.
4. Select Submit icon ( ).
5. The workflow icon for that organization should change to a padlock ( ).

Submitting Multiple Organizations
Some users may be responsible for multiple organizations. If you have a Group or an MAU listed in the organizational hierarchy, it is possible to submit all of them at once; however, the organizations must be submitted in the bottom-up order: Organizations -> Groups -> MAU.

If you are responsible for an entire Group or MAU, you can open all of your organizations in a single window. This allows you to submit more than one at a time. The following is an example of submitting an entire Group of Organizations.
Steps

1. Submitting **Organization(s)** within an MAU.
   - Select one of your group lines to open all organizations within a group in the “Which is made up of:” section of the screen.
   - Open all organizations in a group and “Take Ownership” if not already the owner.
   - Select Submit ( ) for each organization.
   - Repeat the above steps for all groups within a MAU.

![Example of Organizations Submitted on Workflow Screen]

2. Submitting **Group(s)** within an MAU.
   - Select MAU (All) to open all groups in the “Which is made up of:” section of the screen.
   - Open all groups.
   - Select Submit for each group -- if an error message appears than check validation rules.

![Example of Group(s) Submitted on Workflow Screen]
3. Submitting **MAU** support staff raise data to the Human Resources office.
   - Select MAU organization within “You are a reviewer for:” section of the screen.
   - Open MAU organization.
   - Submit the MAU’s faculty raise data -- *if an error message appears than check validation rules.*

![Example of MAU Submitted on Workflow Screen](image)

The MAU’s faculty raise data will be locked and submitted to Human Resources Office when the organizations, groups, and MAU have been submitted.

**Rejecting Organizations**

If you have submitted an organization, but still need to work on it, use the reject option. Rejecting an organization is done the same way as submitting except the order is top down: MAU -> Groups -> Organizations. If an entire MAU is submitted, you will need to contact Human Resource contact or Office of Planning and Budgets contact to reject the organization.

Select reject either from the Workflow Actions screen, or from the grid by clicking the reject icon ( ). The reject changes the workflow from Locked to Work in Progress. The raise plan then must be modified and resubmitted.
Chapter 13: Print Data

Quick Load to Excel
You can quickly export to a tab in Excel. Access the quick export from the File menu by selecting Export, then Quick Export or right-click in the grid and select Quick Export from the context menu. Excel opens with the data from the current tab.

Note: It is best to suppress zero rows and columns before exporting data to Excel.

Steps
1. Click on File from menu
2. Select Export and Quick Export
3. Excel opens
4. Format sheet and print
Chapter 14: Professional Raise Report

Professional Raise Report–DRAFT–RAI002
This report details the raise data submitted by MAUs before input in the SAP system. This is preliminary data which is subject to further review. Prompts include: fiscal year, professional employee groups, supervisor, and organization.

The following format is shown in this professional raise report for organization(s) or supervisor selection within the prompt page:

- Summary totals
- Listing of all employees for organizations selected
- Listing of employees for each organization selected

Path to report: Public Folders > Budget Folder > University Budget Reports > Raise Process > Professional Raise Report–DRAFT–ROI002
1. Install Cognos Contributor Web Client on all laptops or desktops that will be used in the raise process.
2. Be sure all staff that will need to enter raises has appropriate security rights.
3. Enter each person’s Merit raise. Data entry will be made on the Raise Allocation Prof tab.
4. Enter the MERIT raise amount into the Actual MERIT Raise Given column.
5. If you have decided to give the recommended raise amount, simply copy the values from the MERIT Raise $ column to the Actual MERIT Raise Given column.
6. If a raise amount has been entered within "OPTIONAL Special Increase $" column, then do the following:
   - SELECT "See Attachment" within "Insert JUSTIFICATION for OPTIONAL Special Increase" column.
   - INSERT justification documentation within the same cell.
7. Raise control figures for the merit increase must be fully used at the MAU level. Total raise dollars given at the UNIT level may be greater or less than the control. A hard stop has not been entered in the model, but MERIT control totals are to be adhered to closely at the MAU level. Human Resources will not accept any final submissions until MERIT raise amounts are met and not exceeded.
8. When data entry is complete, click the icon on task bar with the green background and white check mark. This will perform a validation check.
9. When validation is complete, the model should be submitted to the appropriate reviewer.
10. For questions, please contact Rebecca Hallisy, 517-884-0115, e-mail hallisy@msu.edu or Karin Root (email only), root.k@hr.msu.edu.

**REMEMBER – Save Often and Take Ownership to Enter Data**
For Questions

Human Resources
(Eligibility and Raise Entry/Processing)
Rebecca Hallisy
hallisy@hr.msu.edu
884-0115

Office of Planning and Budgets
(Functionality Questions about Cognos Raise Tool)
Denice Beckwith
beckwi37@msu.edu
353-0864

Resource guide for the raise applications are available on the Planning and Budgets web page
https://opb.msu.edu/functions/budget/cognos.html
Definitions

Annual Salary: The salary rate actually paid to the employee given their current employment percent

Full Time Equivalent (FTE) Salary: The salary rate at a full time percent of employment (i.e., 100%)

General Increase: The contractually agreed upon flat percent increase for the new raise year. View only, non-modifiable.

Leave Status: Indicator of whether or not the employee is on a leave of absence.

Optional Special Increase: Enter much like the merit. Any increase will require justification and approval from Central Human Resources. Increase amount to be funded by department.

R01: The raise model for the faculty and academic staff non-union raise process within the Cognos Enterprise Planning System

R02: The raise model for the faculty and academic staff union raise process within the Cognos Enterprise Planning System

R03: The raise model for the Professional (including Nurses) and Supervisory support staff raise process with in the Cognos Enterprise Planning System

Contributor Web Client Definitions

Application: An application is a planning model. One application can be used by many users in different locations at the same time.

Break back: A function that changes the value of variables to make a formula equal to a specified value. If you type an amount into the Total cell for Jan through Dec and press Enter, the amount is automatically divided over the 12 months.

Commentary: Represents any additional information attached to Contributor cells, tabs, or e.List items, including both user annotations and attached files.

Cubes: A cube is similar to a spreadsheet. A cube always contains rows and columns and usually at least one other page, making it multidimensional. It is used to collect data. Cells in cubes can contain entered data or calculations.

Dimensions: The rows, columns, and pages of a cube are created from dimensions. Dimensions are lists of related items, fiscal year, organization, object codes, semesters and months.

Dimension Bar: Shows the dimensions that are in the rows, columns, and context.
**D-Links:** Cubes are linked by a series of D-Links in Analyst. A D-Link copies information in and out of cubes, and sometimes to and from ASCII or text files.

**e.Lists:** The structure of an application is based on an e.List. An e.List is a kind of dimension that contains a hierarchical structure that reflects the structure of the university. For example, it may include MAU and department organizations. There is one e.List per application, and the e.List item is assigned to a group/role.

**Grid:** Where you add or edit data.

**Grid Handles:** Where a dimension or tab can be “grabbed” to move it within the grid.

**Help Icon (🪄):** Clicking on the help icon will bring up the Contributor Web Client User Guide. This is a handy guide when working with Contributor, including explanations of to work with screens.
Other Functionality in Contributor

Hide Rows and Columns
You can hide individual or sequential selections of rows or columns or non-sequential selections.

- To select a group of non-sequential rows or columns, click the desired row or column and then Ctrl+click the additional rows or columns. Right-click the header of any selected row or column, click Hide Selected. The selected rows no longer appear in the grid.
- To show hidden rows and columns, right-click on any header and click Show all hidden.
- You can also show hidden rows and columns by selecting Reset Grid only or Reset both Tabs and Grid from the View menu, Reset Views.

Contributor Help Text
Contributor Help Text is a brief text message that appears at the bottom of the tab. Instructions can be different for every cube.

Also, help text will appear as a light bulb icon (💡) within column headings or rows.

Use Edit Options to Cut, Copy, Paste and Delete Data
You can cut, copy, paste and delete data in the grid. When pasting into multiple cells, the format of the target cells must be compatible with the data you are pasting into it. For example, you cannot paste a number into a cell that expects a date.

Step
Select the required data or cells, right-click and select the appropriate option from the menu.
Apply or Release a Hold
You can apply a hold to a cell which means that if break back is used, the held cell is protected from it. A held cell is turquoise in color.

**Step to Apply a Hold**
To apply a hold, right-click the cell, and select **Hold**.

**Step to Release a Hold**
To release a held cell, right-click the cell, and select **Release**.

Reset Data
You can reset all data in all of the tabs to the last saved version. This also resets commentary.

**Step**
From the File menu select Reset All.

Quick Copy Commands
Copy commands copy a value or operation to the left, right, above, or below rows and columns on a single tab. Copy commands perform an action on cells of the same type as the one they were entered in and only apply to the current grid. You can combine copy and data entry commands.

The following table lists the quick copy commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
</table>
| >       | Copies Right | **Example:** 5>
|         |             | Copies the number 5 to the right |
|         |             | **Example:** inc6>
|         |             | Increases the row by 6% for each value to the right |
| <       | Copies Left | **Example:** add15<
|         |             | Adds 15 to each value in the row to the left |
| | Copies Down | **Example:** 3|
|         |             | Copies 3 down the column |
|         |             | **Example:** reset|
|         |             | Resets the cells down the column to the last saved value. |
| ^       | Copies Up   | **Example:** Hold ^
|         |             | Holds the cell values up the column |
|         |             | **Example:** 2>^
|         |             | Copies 2 to the right and up the column |
| :      | Copy Stopper | Used in conjunction with a copy command to stop copying beyond the cell |
## Quick Data Entry Commands

Typing a data entry command in a cell performs an action on the cell value. Data entry commands are processed when you press Enter and only apply to the current grid. These commands are not case sensitive. You can use commands across two dimensions, but not across pages.

The following table lists the quick data entry commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>Enters the value in thousands</td>
<td><strong>Example:</strong> 5K Gives a value of 5,000</td>
</tr>
<tr>
<td>M</td>
<td>Enters the value in millions</td>
<td><strong>Example:</strong> 10M Gives a value of 10,000,000</td>
</tr>
<tr>
<td>Add, +</td>
<td>Adds a number to the cell value</td>
<td><strong>Example:</strong> add8 Adds 8 to the cell value</td>
</tr>
<tr>
<td>Subtract, Sub</td>
<td>Subtracts a number from the cell value</td>
<td><strong>Example:</strong> sub8 Subtracts 8 from the cell value</td>
</tr>
<tr>
<td>Multiply, Mul, *</td>
<td>Multiplies the cell value by a number</td>
<td><strong>Example:</strong> mul3 Multiplies the cell value by 3</td>
</tr>
<tr>
<td>Percent, per, %</td>
<td>Multiplies the cell value by a number added as a percentage</td>
<td><strong>Example:</strong> per5 Gives 5% of the original cell value</td>
</tr>
<tr>
<td>Increase, Inc</td>
<td>Increase the cell value by a number</td>
<td><strong>Example:</strong> inc6 Increase the cell value by 6%</td>
</tr>
<tr>
<td>Decrease, Dec</td>
<td>Decreases the cell value by a number added as a percentage</td>
<td><strong>Example:</strong> dec6 Decrease the cell value by 6%</td>
</tr>
<tr>
<td>Power, Pow</td>
<td>Takes the cell value to the number added as an exponent</td>
<td><strong>Example:</strong> Pow10 Raise the value to the power of 10</td>
</tr>
<tr>
<td>Divide, Div, /</td>
<td>Divides the cell value</td>
<td><strong>Example:</strong> Div1.1 Divides cell value by 1.1</td>
</tr>
<tr>
<td>Reset, Res</td>
<td>Resets selected cell values to the last saved version</td>
<td></td>
</tr>
<tr>
<td>Zero, Zer</td>
<td>Makes the cell value a zero</td>
<td></td>
</tr>
<tr>
<td>Round, Rou</td>
<td>Rounds cells to the appropriate level based on input</td>
<td><strong>Example:</strong> Round100 Rounds all cells to the nearest 100, where 5,475 becomes 5,500</td>
</tr>
<tr>
<td>Hold, Hol</td>
<td>Holds the cell value from break back calculations</td>
<td></td>
</tr>
<tr>
<td>Release, Rel</td>
<td>Releases held cells</td>
<td></td>
</tr>
</tbody>
</table>